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Computer Fundamentals

A computer is an electronic device,

operating under the control of

instructions stored in its own memory

that can accept data (input), process

the data according to specified rules,

produce information (output), and

store the information for future use.





COMPUTER COMPONENT



Hardware

The term hardware refers to the physical components of your computer such

as the system unit, mouse, keyboard, monitor etc.

Software

The software is the collection of instructions that makes the computer work.

For instance, when you type in words via the keyboard, the software is

responsible for displaying the correct letters, in the correct place on the

screen.



Types of Computer
1) Mainframe computer

It is a type of computer used in giant institutions in

industry, statistics, and economic operations. These

computers were placed in huge rooms and were covered

in metal boxes.

Almost all mainframe computers have the ability to run

more than one operating system on the same device.

Therefore, it is possible to operate more than one device,

which is known as virtual devices. One mainframe can

replace hundreds of server computers.



2) Personal Computer(PC)

Personal computer (PC), a digital computer designed for

use by only one person at a time. A typical personal

computer assemblage consists of a central processing

unit (CPU), which contains the computer’s arithmetic,

logic, and control circuitry on an integrated circuit; two

types of computer memory, main memory, such as

digital random-access memory (RAM), and auxiliary

memory, such as magnetic hard disks and special optical

compact discs, or read-only memory (ROM) discs (CD-

ROMs and DVD-ROMs); and various peripheral devices,

including a display screen, keyboard and mouse, and

printer.



3) computer network

A computer network is a system that connects

two or more computing devices for transmitting

and sharing information. Computing devices

include everything from a mobile phone to a

server. These devices are connected using

physical wires such as fiber optics, but they can

also be wireless.

The first working network, called ARPANET, was

created in the late 1960s and was funded by the

U.S. Department of Defense.



4) Laptop

A handheld personal computer (PC) is a pocket-sized computer

typically built around a clamshell form factor and is significantly

smaller than any standard laptop computer, but based on the

same principles.

Most handheld PCs use an operating system specifically designed

for mobile use. Ultra-compact laptops capable of running

common x86-compatible desktop operating systems are typically

classified as subnotebooks.

The name Handheld PC was used by Microsoft from 1996 until

the early 2000s to describe a category of small computers having

keyboards and running the Windows CE operating system.



What does the computer do?

1. Input— entering data into the computer.

2. Processing— performing operations on the data.

3. Output— presenting the results.

4. Storage— saving data, programs, or output for future 
use.





1- Input Devices:

An input device is any hardware component that allows you the

user to input data (text, images, and sounds) and instructions into

the computer to be processed. The most commonly used input

devices are:

Keyboard: Main input devices you use to control your PC and

type letters, numbers, and symbols and commands into the

computer.

Mouse: Pointing devices you use to control your PC. Click the

mouse allows you to enter data by pressing the button. There

are many operations that are much easier to perform with a

mouse than a keyboard because you can just point and click to

select an item on a screen or choose an item from a list of

options.



Microphone: The microphone is usually used for

input sounds and instructions into the computer

Scanner: This input device generates a digital

representation of an image for data input (such as

text and pictures) to a computer

Digital camera: The digital camera allows you to

take pictures or create movie that you can input

into your computer.

PC video camera (Web Cam):The PC video

camera allows you take both video and still

images that you can input into your computer



2- Output Devices
An output device is any hardware component that gives information to the user and send processed

data out of your computer. When you send inputs into the PC, it processes them and produces useful

output for you.

The most commonly used output devices are as follow:

A Monitor(display screen):This output device displays your information (text, graphics, and videos) on

a screen.

A Printer: Used to prints information on paper.

A Speaker: Sound output you will get from a speaker. Speakers allow you to hear (music, voice and

other sounds) and let a lots of people listen.

Headphones: Keep the sound to one person.



Monitor(display screen)

Printer

Speaker
Headphones



Lecture 2
Windows 10 Desktop

Assistant Lecturer. Shahad Laith



Windows 10 Desktop

It is a version of the Windows computer operating system, produced

by Microsoft, that was discovered in 2014, and released in 2015. What

was not expected is that the name of this new version will be

“Windows 10” and not “Windows 9.” The company announces that

the name “Windows 9 will not fit the big leap the company has made

in the operating system



After logging the computer, Windows 10 desktop will be appeared. 

The Desktop layout is as follows:

1. Desktop Shortcuts

Create a Shortcut

Follow these steps to add a shortcut to your desktop.

Right-click a file, folder, or app, and then choose Send

to.

Choose Desktop (create shortcut).

A shortcut to the item appears on your desktop.



2.The Taskbar

The Taskbar is a graphical user interface element that has been part of

Microsoft Windows since Windows 95, displaying and facilitating switching

between running programs.



3.The Start Menu

The Start Menu is the main point of access to your applications. There are

two main ways to open it

Step 1 − Use your mouse to click Windows icon in the lower-left corner of

the taskbar.

Step 2 − Press the Windows key on your keyboard.



The Windows 10 Start Menu features two panes.



A. Left Pane

1. Click the username at the top of the menu to

change account settings or log in with another

user.

2. Access the applications you use more frequently.

3. A small arrow next to an application will open a

sub-menu with a list of recent documents opened

with that application.

4. Open the “File Explorer” to navigate your folders

and files.

5. Change the settings of your computer like your

Internet connection or changing your background.

6. See different options to shut down your computer.

7. See a list of all the applications installed in your

computer.



B. Right Pane

1. The right pane features a varied array of tiles,

similar to the ones that were seen on the

Start Screen of Windows 8.

2. These tiles can be moved and dragged to

different places by holding the mouse button.

3. You can also configure them by right-clicking

on them to see options to resize them or

“unpin” them (remove them) from the Menu.

4. The whole Start Menu can also be resized by

dragging the borders with the mouse to the

desired size.



4.Windows Search 

The “Search box” on the Taskbar will

allow you to search within your

documents and files or on the Web for

anything you write. The initial results

will appear within the Start Menu

itself.

The results will be grouped according

to the closest match (or matches)

labeled “Best match” at the top of the

list.



The remaining results will be grouped according
to what they are or their location

• Web results

• Documents or folders

• Apps

• System settings



5. Date/Time

How to change date and time formats on Windows 10

A. Open Settings.

B. Click on Time & language.

C. Click on Date & time.



D. Under format click the Change date and time formats link.

E. Use the Short name drop-down menu to select the date format you

want to see in the Taskbar.

F. Use the Short time drop-down menu to select the time format you want

to see in the Taskbar.
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Working with files and folders 

Understanding how to work with files and folders is an important part

of using your computer. Once you understand how files and folder

work, you'll use them all the time. In this lesson, we'll show you the

absolute basics of working with files, including how to open files, move

your files into folders, and delete files.



What is a file?

There are many different types of files you can

use. For example, Microsoft Word documents,

digital photos, digital music, and digital videos are

all types of files. You might even think of a file as

a digital version of a real-world thing you can

interact with on your computer. When you use

different applications, you'll often be viewing,

creating, or editing files.

Files are usually represented by an icon. In the

image below, you can see a few different types of

files below the Recycle Bin on the desktop.



What is a folder?

Windows uses folders to help you organize files. You can put files inside a

folder, just like you would put documents inside a real folder. In the image

below, you can see some folders on the desktop.



To open a file:

The process of opening the file takes

place in two basic ways: double-

clicking the left mouse button on the

file

The second method is by pressing the

right mouse button once. A menu will

appear from which we can choose

Open, then the file will open.

The same applies to opening any

folder



Moving and deleting files

To move a file:

It's easy to move a file from one

location to another. For

example, you might have a file

on the desktop that you want to

move to your Documents folder.

1. Click and drag the file to the

desired location.



2. Release the mouse. The file will appear in the new location. In this

example, we have opened the folder to see the file in its new location.



To create a new folder:

To create a new folder, there are two
ways

1- Either by right-clicking on any
empty place on the desktop if we
need to create a new folder on the
desktop, then we choose New, then
we choose Folder.



To create a new folder:

2. Within File Explorer, locate and select the New folder button. You

can also right-click where you want the folder to appear, then

select New > Folder.



2. The new folder will appear. Type the desired name for the folder and press

Enter. In our example, we'll call it School Documents.

3. The new folder will be created. You can now move files into this folder.



To rename a file or folder:

You can change the name of any file

or folder. A unique name will make it

easier to remember what type of

information is saved in the file or

folder.

right-click the folder and select

Rename from the menu that

appears.



To delete a file or folder:

If you no longer need to use a file, you can

delete it. When you delete a file, it is moved to

the Recycle Bin. If you change your mind, you

can move the file from the Recycle Bin back to

its original location. If you're sure you want to

permanently delete the file, you will need to

empty the Recycle Bin.

1. Click and drag the file to the Recycle Bin icon

on the desktop. You can also click the file to

select it and press the Delete key on your

keyboard.



To permanently delete the file, right-click the Recycle Bin icon and

select Empty Recycle Bin. All files in the Recycle Bin will be

permanently deleted.



Selecting more than one file

ere are a few ways to select more

than one file at a time:

If you're viewing your files as icons,

you can click and drag the mouse to

draw a box around the files you want

to select. When you're done, release

the mouse; the files will be selected.

You can now move, copy, or delete all

of these files at the same time.
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Getting to know Word 2010

Word 2010 is designed to help you create

professional-quality documents. Word can also

help you organize and write documents more

efficiently

The Word interface

When you open Word for the first time, the Start

Screen will appear. From here, you'll be able to

create a new document, choose a template, and

access your recently edited documents. From the

Start Screen, locate and select Blank document to

access the Word interface.
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1. The Quick Access Toolbar lets you access common commands no matter
which tab is selected. By default, it includes the Save, Undo, and Redo
commands.

2. The Ribbon contains all of the commands you will need to perform
common tasks in Word. It has multiple tabs, each with several groups of
commands.

3. Each group contains a series of different commands. Simply click any
command to apply it. Some groups also have an arrow in the bottom-right
corner, which you can click to see even more commands.

4. The Ruler is located at the top and to the left of your document. It makes
it easier to make alignment and spacing adjustments.



5. Click and drag the vertical scroll bar to move up and down through the pages
of your document.

6. This is where you'll type and edit text in the document.

7. From here, you can quickly see the number of words and pages in your
document.

8. There are three ways to view a document:

• Read Mode displays your document in full-screen mode.

• Print Layout is selected by default. It shows the document as it would appear
on the printed page.

• Web Layout shows how your document would look as a webpage.

9. Click and drag the slider to use the zoom control. The number to the right of
the slider bar reflects the zoom percentage.



The area outlined contains the minimize, maximize/restore and close buttons

for the program window.

These three buttons are on almost every window that opens in a Windows

based platform.



When you click the minimize button the program becomes a button on the

Windows taskbar located at the bottom of the screen

When you click the maximize / restore button the program assumes the

same shape and size it was before you minimized it. Or The program window

will fill the screen.

When you click the close button the program will ask you if you want to save

the changes if you have made any changes. Once you have responded to this

question the program will close.



The area outlined in red is called the quick access toolbar. It contains the

most commonly used commands in Microsoft Word:

• Save

• Undo

• Repeat

Microsoft Office 2007 & 2010 use what is referred to as the "Ribbon"

interface. The area outlined in red comprises the Ribbon.



• The Words File, Home, Insert, etc... outlined in red are referred to as tabs.

Each tab has several Groups attached to it.

1. The File Tab menu contains the commands most commonly associated

with the file.



2. The Home Tab Groups contain the commands most commonly

associated with the formatting and editing of text.

• Clipboard

• Font

• Paragraph

• Styles

• Editing



3. The Insert Tab Groups contain the commands most commonly associated with

adding something to the document.

• Pages

• Tables

• Illustrations

• Header/Footer

• Links

• Text

• Symbols



4. The Page Layout Groups contain the commands most commonly

associated with settings that would affect the entire page or document.

• Themes

• Page Setup

• Page Background

• Paragraph

• Arrange



5. The References Groups contain the commands most commonly associated with

writing a research paper, essay, term paper or similarly formal documents.

• Table of Contents

• Footnotes

• Citations & Bibliography

• Captions

• Index

• Table of Authorities



6. The Mailings Tab groups contain the commands most commonly associated with

documents and files created for mass mailing.

• Create

• Start

• Mail Merge

• Write & Insert

• Fields

• Preview

• Results

• Finish



7. The Review Tabs groups contain the commands most commonly associated with

documents which are shared or being prepared for publication.

• Proofing

• Language

• Comments

• Changes

• Tracking

• Compare

• Protect



8. The View Tab groups contain the commands most commonly associated

with the variety of ways you can "look at" a document or documents.

• Document

• Views

• Show

• Zoom

• Window

• Macros
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You can use Word to accomplish the following tasks:

1. Type and edit text.

2. Copy and move text from one location to another.

3. Format text and paragraphs with fonts, colors, and other elements.

4. Format and design pages.

5. Enhance documents with tables, charts, graphics, screenshots.

6. Use Mail Merge to create form letters and mailing labels.

7. Share documents securely.



• The title bar displays the name of the document and the name of the program.

• Until you give a new document a different name, its temporary name is Document 1.

• Quick Access toolbar: located in the left side of the title bar which includes buttons for saving a

document and for undoing, redoing, and repeating a change.

• Ribbon Display Options button: located in the right side of the title bar, you use to hide or show the

Ribbon and tabs, the resizing buttons, and the program Close button.

• The File tab provides access to Backstage view where you manage files and the information about

them.

• Backstage view: includes commands related to working with documents, such as opening, printing,

and saving a document.



• the Tell Me box, which you can use to find a command or access the

Word Help system,

• the Share button, which you can use to save a document to the

Cloud.

• The document window displays the current document.

• You enter text and format your document in the document window.

• The rulers appear in the document window in Print Layout view.



• The horizontal ruler: displays left and right document margins as well as

the tab settings and paragraph indents, if any, for the paragraph in

which the insertion point is located.

• The vertical ruler: displays the top and bottom document margins.

• The vertical and horizontal scroll bars: are used to display different

parts of the document in the document window.

• The scroll bars include scroll boxes and scroll arrows, which you use to

scroll.



• Status bar: Located at bottom of Program window and displays the

page number of the current page, the total number of pages and

words in the document, and the status of spelling and grammar

checking.

• It also includes the view buttons, the zoom slider, and the Zoom level

button.

• The view buttons on the status bar allow you to display the

document in Read Mode, Print Layout, or Web Layout view.



• Red wavy :line under a word indicates a possible misspelling or a

repeated word;

• Blue wavy line under text indicates a possible grammar error.

• Spelling and grammar checking is one of the many automatic

features you will encounter as you type.

• AutoCorrect: automatically makes typographical adjustments,

detects, and adjusts typing errors, certain misspelled words, and

incorrect capitalization as you type.



• AutoComplete suggests text to insert quickly into your documents.

• Press [Enter] to insert the text suggested by the Screen Tip; continue

typing to reject the suggestion.

• Pressing [Backspace] removes the character before the insertion

point.

• Pressing [Delete] removes the character after the insertion point

Automatic features that appear as you type in Word.



Save a Document

first time you save a document, the Save As screen opens.

The default filename is based on the first few words of the document.

press [Ctri][S] to save a document.



Select Text

• Before deleting, editing, or formatting text, you must select the text.

• Formatting marks are special characters that appear on your screen

but do not print.

• Selecting text involves clicking and dragging the left click pointer

across the text to highlight it.



Methods for selecting text
• To select any amount of text: Drag over the text.

• To select a word: Double-click the word.

• To select a line of text: Move the pointer to the left of the line, then click.

• To select a sentence: Press and hold [Ctr+L], then click the sentence.

• to select entire document: Triple-click with the pointer to the left of any

text; press [CtrI][A].



Find and Replace Text

• Using the Replace command, you can find and replace all occurrences

of specific text at once, or you can choose to find and review each

occurrence individually.

• Using the Find command, you can locate and highlight every

occurrence of a specific word or phrase in a document.



Types of indents
• Left indent: The left edge of a paragraph is moved in from the left margin.

• Right indent: The right edge of a paragraph is moved in from the right margin.

• First line indent: The first line of a paragraph is indented more than the

subsequent lines.

• Hanging indent: The subsequent lines of a paragraph are indented more than the

first line.

• Negative indent (or Out dent): The left edge of a paragraph is moved to the left

of the left margin.



Add Bullets and Numbering

• Formatting a list with bullets or numbering can help to organize the

ideas in a document.

• A bullet is a character, often a small circle, that appears before the

items in a list to add emphasis.

• Formatting a list as a numbered list helps illustrate sequences and

priorities.



Add Headers and Footers

• A header is text or graphics that appears at the top of every page of a

document.

• A footer is text or graphics that appears at the bottom of every page.

• headers and footers often contain the title of the publication or

chapter, the name of the author, or a page number.

• When the header and footer areas are open, the document text is

dimmed and cannot be edited.


